ITVoyagers (itvoyagers.in)

Practical 1

Creating and Managing Vector Data: Adding vector layers, setting properties,
formatting, calculating line lengths and statistics

Adding vector layers

Layer > Create Layer > New Shapefile Layer

# QGIs 2.18.26 - X

Create Layer
D L+ | Add Lay

Project Edit View

Settngs  Plugins  Vector Raster Database Web Processing  Help

"', New Shapefile Layer... Ctrl+shift+

LIS & &l = T~
* | #2 New Spatialite Laver... i e z ¢
EA:ZE:L ) Nev ae Layer.. g, 2 5 A
m @ New Temporary Scratch Layer.. : >
Copy style Ec
Vo [ @ N0 Pesteste ent Projects
] romd £ Open Attriute Table F&
o )
£a
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a )
rc Crl4shift+C
9 @ A6l setProject CRS from Layer
(+] ‘®‘ OI‘""S Properties...
Tie g
5 H @ weg| P Ctl4F
& wrs|™ Labeing
Vo, | @ WMS|9O add to Overview
75 Add All to Overview
“F Remove All from Overview
@ Show AllLayers Crl+shift+U
Hide All Layers Cirl4shift+H
< @ % showselected Layers
Hide Selected Layers
There is a new QGIS versi ilable: qais.org to get your copy of version 3.4.2
Coordinate W scale|1:32,150,774 ¥ @ Maonifier 100% > Rotation 0.0 T % Rencer @hepsaiaize @

H 0 Type here to search

For creating Lake Layer select
Type — Polygon
File encoding — system

CSR - EPSG:4326,WGS 84

To Add attributes(eg:)
Name — name

Type — Text data
Length — 80

And click on “Add to field list”.

1|Pgge


http://itvoyagers.in/

ITVoyagers (itvoyagers.in)

7

Project Edit View Layer Settings Plugine Vector Raster
= = N
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Browser Panel
Ve cevae
= ome
Favourites

£ spatalite

& ArcGisFeatureServer
& ArcGisMapServer
&) ows

& Tie Server (xY2)
& wes

) wrs

\,)” - & wms

Layers Panel

8l & TV & ~F 0

Databaze  Web

abe

Recent Pi

v } Mew Shapefile Layer

Processing  Help

x
Type
Paint Line ® Polygon
File encoding System -
Selected CRS (EPSG:4325, WGS 84) -
Hew field

name [| ]

Type [Textdata

Fields list
Name Type Length Precision
id Integer 10

(€1

Cancel Help

There is a new QGIS version available: Visit http://download. gis.org to get your copy of version 3.4.2

H 0 Type here to search

Project Edit View Layer Settings Plugine Vector Raster

DEBRLE®

Databaze  Web

v } Mew Shapefile Layer

Coordinate ¥ scale|1:32,150,774 *

Processing  Help

Magnifier | 100%

Rotation

X 2] [
) e
(5] Type
Erowsar Panel Paint Line ® Polygon
Ve loevae Recent Pi
File encoding System -
o
Favourites Selected CRS (EPSG:4325, WGS 84) -
£ < New field
D/
@ - E/ Name | name
Fif
- DE2 Type [Textdata -
P vssqu
G postars £ Add to fields st
:: £ spatalite
& ArcGisFeatureServer
i b [Add field to st
& ArcGisMapServer Fields list
&) ows )
@ Tile Server (xv2) Name Type | Lengthn | Precision
@ wes id Integer 10
) wrs
Vo, v B s
Layers Panel
o« @ ® T ¢ i = Al AaD
2 Remove field
Cancel Help
There is a new QGIS version available: Visit http://download. gis.org to get your copy of version 3.4.2
Coordinate W scale 132,150,774 Magnifier | 100% 2 Rotstion 0.0 X Render D epsciazze @

H 0 Type here to search
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Project Edit View Layer Settings

DEBRLE®

Plugins
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B Home
o Favourites
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MssqL
@ Orade
@ postars
£ spatalite

& ArcGisFeatureServer

& ArcGisMapServer

) ows

& Tie Server (xY2)
wes

=]
) wrs
V..~ & wms
Leyers Panel
o« @ ® T ¢ i =
H 0 Type here to search
)
Project Edit View Llayer Settngs Plugins Vector Raster

DEBRLEM
o o =€

Erowser Panel

T* O

Home
Favourites
cf
D/

Eif
Fif

9 D62
MSSQL

@ Orade

@ postars

£ spatalite

& ArcGisFeatureServer

& ArcGisMapServer

) ows

& Tie Server (xY2)

& wes

) wrs

& wms

V% ae
'é =]
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AVl

Layers Panel

« 4 ® T E-H T

H 0 Type here to search

Raster

Rotation

0.0

2 [ Render

Derseiaze @

Database Web Processing Help
=
& '/ New Shapefile Layer ? x [ @
= Type
Paint Line ® Polygon
File encoding System -
Selected CRS (EPSG:4325, WS 84) - E]
Hew field
Name | area
Type | Whole rumber -
Text data
Length |
Decmal number
Date
Fields list
Name Type Length Precision
id Integer 0
name String 80
(€| ] (1+]
%) Remove field
Cancel Help
There is a new QGIS versi GTaie agis.org o get your copy of version 3.4.2
Coordinate W scale|1:32,150,774 |~ @ Magnifier | 100%
Database Web Processing Help
=
& '/ New Shapefile Layer ? x [ @
= Type
Paint Line ® Polygon
Recent P
File encoding System -
Selected CRS (EPSG:4325, WS 84) - E]
Hew field
Name
Type  [ifhole number -
Add to fields list
Fields list
Name Type | Lengthn | Precision
id Integer 0
name String 80
area Integer
(€| ] (1+]
%) Remove field
Cance Hep
There is a new QGIS GTaie agis.org o get your copy of version 3.4.2
Coordinate W scale|1:32,150,774 |~ @ Magnifier | 100%

Rotation

0.0

2 [ Render

Derseiaze @

After'adding allHfrelds{attributes) click-on“OK"

It will ask you to name the layer, Enter “lake”. Extension will be “.shp”

Click on “Save”
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7 Savelayer as... »
~
» H Sl

Organize New folder = @ P csw ﬁ)

& 1 = = T~ n
k- @ mm Y g

« v « Sarvasva » QGIS » 1 v | O

[ This PC Name Date modified Type

J 3D Objects No items match your search.
1B Desktop

£ Documents

4 Downloads

B Music

=) Pictures

B videos

‘e Local Disk (C)

= New Volume (E)

File name: | lake] ~

Saveastype: |ESRI Shapefile [OGR] (*.shp *.SHP) v

~ Hide Folders Cancel

Leyers Panel
o« @ ® T ¢ i =

There is a new QGIS versk ilable: qais.org to get your copy of version 3.4.2

Coordinate ¥ scle|132,150,774 | @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Lake layer will appear in Layer Panel.
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Project Edit View layer Setngs Plugins Vector Raster Database Web Progessing Help

S B LI | —
DEEBRREX e “ 5 m- e [T
- = _— o e & @ o
4 & /x M ¢ W B = = =% e,
Layers Panel
Yo |« 3w T &F A0
x [l ke
lake (EPSG:4326)
E:/Sarvasva/QGIS/ Iiske.shp
Browser Panel
LeT®eo
Home
Favourites
b cf
Dif
w Eif
il
VAR eoaz
MssQL
@ orade
@ rosters
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer
@D ows
& Tie Server (xvZ)
@ wes
7 wrs
& wms
Coordinate -1.716,0.207 W scle| 111,466,527 |~ @ Megnifir 100% |2 Rotation 0.0 S ®Render @Depsciaze @

2030
H O Type here to search il ) 16-12-2018 E,

Select lake layer and click on ) “Toggle Editing” and then click on [
“Add Feature”
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Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help
== g 2 P O [ oNoNe) oy A
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& Home
Favourites
%% I
D:f
%] B/
Fif

Avand ? DBz
MsSQL

@ orade
@ postars
£ spatialite
& ArcGisFeatureServer
@ ArcGisMapServer
) ows
& Tile Server (x¥Z)
& wes
& wrs

® wms

Toggles the editing state of the current layer Coordinate -1.716,-0.207 W scle| 11,466,527 v @ Maonfier 100% |3 Rotaton 0.0 2 ®Render Dersgiazze @

H 0 Type here to search
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LRERTHO
Home
Favourites

=]
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m

& ArcGisFeatureServer
& ArcGisMapServer
D ows

& Tie Server (xYZ)
@ wes

& wrs

& wms

Coordinate -1.751,0.544 W scale| 11,466,527 |~ @@ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

H O Type here to search

Start creating your first lake by creating polygon in canvas. To do this,
you have to “left click” in canvas and go on till you create your shape for
lake and then press:fright click”
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= = S D O ~ ™ A ~ 2 -3 = ree —
D BELR Q0@ 2 ,pRPPRsRllR @& -T-&-5EEZI =" 0
P/BEr-mri=<00 "SQE=ITRRT ~ &
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) c
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PostGIS
£ spatialite
& ArcGisFeatureServer
& ArcGisMapserver
) ows
& Tile Server (x¥Z)
& wes
& wrs
® wms
Coordinate -1.004,0.372 ¥ scle| 11,466,962 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @
2042

H O Type here to search 0
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Project Edit View layer Setngs Plugins Vector Raster Database Web Processing Help
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Layers Panel
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% Browser Panel A .
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&~ Home
Favourites
b cf

%)
Ve

& ArcGisFeatureServer
& ArcGisMapServer
D ows

& Tie Server (xYZ)
@ wes

& wrs

& wms

Coordinate -1.07%,0.755 W scale| 11,466,462 ~ @@ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

i y ST
H o Type here to search i ) % W 16 199018 E,

Add values to'attributes.

id-1
Name — Dombivali Talav (you can give any name you want)

Area - 10000 (although you can enter your values, but QGIS will not
consider this value while calculating area because it will calculate the
value automatically based on coordinates)
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DEERRR 022 pHPPLALALIORS &
r7BEn- 2R @ S QE N E g A

Layers Panel
\‘g « @ T &~&F @ O
i
= % M take
Fe
& lake - Feature Attributes [ = |
@~
@ Browser Panel id 1
- @T®e name | Dombivali Talav
&~
) Home area [ 10000 ]
Favourites
cf
D:f
£/
R
oK cancel
o Lo || o
MsSQL
@ orade
@ postars
£ spatialite

& ArcGisFeatureServer
@ ArcGisMapServer
) ows

& Tile Server (x¥Z)
& wes

) wrs

® wms

Coordinate -0.937,0.589 % scle| 11,466,527 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Save file by pressingr“ctrl+s’t:

Give name for project and click on “Save”.

# aais2

7 Choose a QGIS project file kS

~E-LEEI = T-' 8B

« v <« Sarvasva » QGIS » 1 ~ |8 Search 1 »p [I

Organize New folder = @ P csw] @
B 3D Objects A Name Date modified Type
[ Deskiop
2] Documents
4 Downloads
D Music

Ne items match your search.

&=| Pictures

B videos

e Local Disk (€3
= New Volume (E)
= HP_TOOLS (F)

. v < >

File name: | pract! w

Save astype: | QGIS files (*.qgs *.0GS) &

~ Hide Folders Cancel
- @ postels

£ spatialite

& ArcGisFeatureServer

@ ArcGisMapServer

) ows

& Tile Server (x¥Z)
wes

) wrs

® wms

Coordinate -0.523,0.278 ¥ scle| 11,466,962 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

For creating other vector layers you have to select

Layer > Create Layer > New Shapefile Layer

7P age


http://itvoyagers.in/

ITVoyagers (itvoyagers.in)

itvoyagers.in voyagers.in itvoyagers.in itvoyager
We are going to create

Footpath layer (type — line)

itvoyagddn imeHb e PR Yhvoyagers. in itvoyagers

Shop layer (type — point)
Road layer (type —line)

itvoyagarerivartray e sive sthetiiolds fastebuter) eashidveEy < in itvoyagers.i

Footpath layer

itvoyagdiie] priningathBedsclick opyBXragers. in itvoyagers.in itvoyagers.i

# QG615 2.18.26

Project Edit View Llayer Settings Plugins Vector Raster Database Web Progessing Help
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F=a ——
'- Name | ]
@v Type | Whole number B3|
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9 Favourite: [T
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B E'f id Integer 10
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Give name footpath.
itvoyagers.in itvoyager

In itvoyagers.in itvoyager
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7 Savelayer as... »

4« Savasva » QGIS 5 1 vie

g EE I =y T

Organize = New folder

0 = csw g
[ This PC A Name Date modified Type

B 3D Objects [] lakeshp 1
[ Desktop

[£ Documents

J Downloads

B Music

=) Pictures

B Videos

i Local Disk (C)

SHP File

= New Volume (E)

>

File name: | footpath|

Saveastype: |ESRI Shapefile [OGR] (*.shp *.SHP) v

~ Hide Folders Cancel
I @ rosas

£ spatialite

& ArcGisFeatureServer
@ ArcGisMapServer

) ows

& Tile Server (x¥Z)
& wes

) wrs

® wms

Coordinate -1.695,0.411 W scle| 11,966,527 v | @ Maonifier | 100%

2 Rotstion 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Shop layer

After entering all fields click on “OK”, save file as shop.
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Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
= B S —
L

g 5_ Mew Shapefile Layer ? x e L m~s [T~

vy CRES I = | Ty
Layers Pane! ® paint Line Polygon
N @ ® T &~F F L
Flle encoding System -
'D X — footpath
lake Selected CRS (EPSG:4325, WGS 84) - E]
/gj New field
@ - Name | ]
@v Type | Textdata -
_ LeT®eo
&~ Project home
Home Fields list
9 Favourites
cf Name Type Length Precision
|7 Dif id Integer 10
3 name String 80
Ef category String 80
VAR i/
D82
MssQL
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer [+1
ws
& Tie Server (xvZ)
@ wes
7 wrs
Cancel Help
& wms
Coordinate -1.755,0.551 W scale| 111,466,962~ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

20
H O ifpelicieliolsarch ) 154‘271013 L
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Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help

= = S + @ oD T N N A = rew —
IeERRR [0 2L P HPPAS 2 e K-uLEEEa T E
2/]! b2 EH " @EARERFR A

Pt | oo
Vo lva@dwvTa-san

Browser Panel

Project home
Home
Favourites
=7}

& ArcGisFeatureServer
& ArcGisMapServer
) ows

& Tile Server (x¥Z)
& wes

& wrs

& wms

Toggles the editing state of the current layer Coordinate -2.358,0.864 W scle| 11,461,317 v @ Maonfier 100% |3 Rotaton 0.0 2 ®Render Dersgiazze @

H O Type here to search 0

20:5

Sele¢t-footpathdayerand-click on:/ Toggle Editing” and-then click on
% “Add Feature”.

Start creating footpath by creating line in canvas. To do this, you have
to “left click” in canvas and go on till you create your path for footpath
and then-press “right click” to.end:

/ QGIS 2.18.26 - pract1 - b4
Project Edit View layer Setngs Plugins Vector Raster Database Web Progessing Help
= B . R ORIONe - e =
DEERLEER 40 pppHPDQARD0R @C-R-5-FEEHZ =-" T~ H
A/BMEn-%RTG« 8 “QE< 2w & A
Layers Panel

Vo lw @ mTars o

Froject home
Home
Favourites

@
B Fyf

? D82
MssQL
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer
) ows
& Tie Server (xYZ)
@ wes
& wrs

& wms

Coordinate -2.376,0.604 W scle| 11,461,317 v @ Magnifier 100%

2 Rotation 0.0 < Render @) erscraze @

i 5 R Sy
0 Type here to search PR % W 16 199018 E,
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8 B & 0

a~ Ve fR @ € I N ST
Layers Panel
@ ® T &~F F L

= [T H

%

Browser Panel
ET®O
Froject home

Home
Favourites

@ rostars

/' spatalite

& ArcGisFeatureServer

& ArcGisMapServer

@& ows

& Tie Server (xYZ)
wes

¥ wrs

& wms

Coordinate -1.091,0.136 W scale| 11,461,317 |~ @@ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

H O Type here to search

Add values to footpath’s attributes.
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Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help
=5 B 1 @ + @ @

DEBRLGR A 082 PP

V5 R T e = ) s m e g A
Layers Panel
« @ T &~&F @ O

&

footpath - Feature Attributes B

Browser Panel
2T=*O
Project home

Home width [ 10] ]
Favourites

id 1

name | lake road

28| O

B-E28E
9

Fif
2 D62
MsSQL
@ orade
@ posters
£ spatialite
& ArcGisFeatureServer
& ArcGisMapServer
) ows
& Tile Server (x¥Z)
& wes
¥ wrs

& wms

Cancel

Coordinate -1.274,0.888 ¥ scle| 11,461,317 v Magnifier | 100% 5| Rotston 0.0 2 ®Render Dersgiazze @

H 0 Type here to search
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B &L

-

e~ Vo fx

B

= g A

Layers Panel

\‘g « @ T &~&F @ O

= % © shop
% # footpath
ﬁ % [ take
(+]
@ -
@ -
@ Browser Panel
oevmxeo £
Project home

Home
Favourites

@ orade

@ posters X

£ spatialite

& ArcGisFeatureServer

& ArcGisMapServer
ows

& Tile Server (x¥Z)
& wes
¥ wrs

& wms

Coordinate -1.393,-0.224 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @
H 0 Type here to search

Garden layer

7z

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

B &

A

> 7 New Shapefile Layer ? x [ @ L m- o -
Vs & s | rype
Layers Panel Point. Line ® Polygon
v & T &R AL
File encoding System -
X ® shop
x| 4 footpath Selected CRS (EPSG:4326, WES 84) vE]
x/ [ rake Hew field
Name
Type |Textdata -
Browser Panel

LT ®HO Add to felds list

Project home e
Home Fields list
Favouritss
o Name Type |Length |Precision
id Integer 10
name string 80
area Integer 10
timming String 10
& ArcGisFeatureServer
& ArcGisMapServer [ D)
ows
) Tie Server (V2) Bpe s ibekd
& wes
P w
B wes Cancel Help
& wms
Coordinate -2.404, 1158 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @
H
H 0 Type here to search
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T <« Sarvasva > QGIS » 1 ~ | D Search 1 »p [I B ﬂ&

- @ [ csw] @

Organize = New folder

[ This PC A Name Date modified Type

) 3D Objects || footpath.shp
[ Deskiop || lake.shp

2] Documents L shop shp
J Downloads

B Music

=] Pictures ) x
B videos 1
Local Disk (C:) i

SHP File
SHP File
SHP File

= New Volume (E)

>

File name: \ garden]

Saveastype: |ESRI Shapefile [OGR] (*.shp *.SHP) v

~ Hide Folders Cancel

@ orade

@ posters X
£ spatialite

& ArcGisFeatureServer

& ArcGisMapServer

) ows

& Tile Server (x¥Z)

B wns

Coardinate -2,404,1,158 W scle| 11,961,317 T Magnifier 100% |+ Rotation 0.0 2 % Render @Persareize @

H 0 Type here to search

Road layer

7z

Project Edit View Llayer Settings Plugins Vector Raster Database Web Processing Help

DEBRR

I Mew Shapefile Layer 7 x rlag

abc|
v Twe
Layers Pane! Point ® Line Polygon
Yo |« §® T &~ L
File encoding System -
- % © shop
% [ garden Selected CRS (EPSG:4325, WGS 84) - E]
/9" % # footpath
New field
g % [ lake
¢ - Name
@v Type | Whole number -
JReT®HO
Project home e
Home Fields list
Favouritss
Name Type Length Precision
id Integer 10
name string 80
width Integer 10
& ArcGisFeatureServer
& ArcGisMapServer [«
) ows
& Tie Server (x¥Z)
& wes
D w
- Cancel Help
& wms
Coordinate -2.346,0.983 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search
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7 Savelayer as... »

~
[« Sarvasva > QGIS > 1 v|® | searchi I @
e @ B v A

Name Date modified Type

Organize = New folder

[ This PC
) 3D Objects || footpath.shp
[ Desktop L] garden.shp
[ 1ake.shp
[ shop.shp

SHP File
SHP File
SHP File

| Documents
& SHP File

4 Downloads
B Music

&= Pictures
B videos

i Local Disk (C) K

= New Volume (E)
v

PR X

File name: | road| ~]

Save as type: [ESRI Shapefile [OGR] (":shp “SHP) ~]

~ Hide Folders Cancel

@ orade
@ posters
£ spatialite
& ArcGisFeatureServer
& ArcGisMapServer
) ows
& Tile Server (x¥Z)
& wes
& wrs

& wms

Coordinate -2.346,0.983 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

/ QGIS 2.18.26 - pract]
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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v resr
o &0 . R 2=

';,;2@'0 T~

Froject home
Home X
Favourites £

@ rostars

/' spatalite

& ArcGisFeatureServer
& ArcGisMapServer
) ows

& Tie Server (xYZ)
@ wes

& wrs

& wms

Toggles the editing state of the current layer Coordinate -2.414,0.748 W scale| 11,461,317 |~ @@ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

211
H O Type here to search s ¥

Now our all{ayers are there'it’s timeto insert shopsin nap-

%o

Select shop layer and click on /] “Toggle Editing” and then click on
“Add Feature”.

To-insert'shop in map-click in‘canvasswhere you-wantta-add-it.
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2T=*O
Project home
Home X
Favourites
cf X
D:f
E:f
Fif
2 D62
MsSQL
@ orade
@ posters X X
£ spatialite
& ArcGisFeatureServer
& ArcGisMapServer
) ows
& Tile Server (x¥Z)
& wes
¥ wrs

& wms

&

28

B-E28E

Coordinate -2.365,0.979 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Givejvalues to the attributes.

a4

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

hEBRE PHPPRABIR @
- ) B g e g s A
Layers Panel

v A ®T &R AL

&

shop - Feature Attributes n

4

Browser Panel id 1

name chocolate pie shop

[
-
8
-

4

-8 M

Project home: category |chocolate saler
Home
Favourites

Cancel

2888

4

& ArcGisFeatureServer
& ArcGisMapServer
) ows

& Tie Server (x¥Z)
& wes

¥ wrs

& wms

Coordinate -1.414,0.081 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search
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Project  Edit
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View  Layer Progessing  Help

P AERP
B = Q' @ =g % @ oy ag csw ﬁ)

2B 5%

kA

Layers Panel
« @l & T &-&F & L

% # shop
®  road
% [ garden
® # footpath
% [#] 1ake

Becwsar Panal
2T®*O
Project home
Home X
Favourites
cf
D:f
B/
Fif
? D62
MsSQL
@ orade
@ posters X X
£ spatialite
& ArcGisFeatureServer
& ArcGisMapServer
) ows
& Tile Server (x¥Z)
& wes
& wrs

& wms

28| O

B-E28E

Coordinate -1.432,0.362 2 Rotstion 0.0 2 ®Render Dersgiazze @

W scale| 11,451,317 v @ Maonifier 100%

H 0 Type here to search

Add fewmore shops:

/ QGIS 2.18.26 - pract]
Project  Edit

DEBRLRR
278 e %

Lzyers Panel
Vo lwa®Tara o

Progessing  Help

Raster

Database
}9‘ L ;l e~
abe Q' [y g o gy s wg oo .‘il>

View layer Settings Plugins Vector Web

& O
fx @

Erowser Panel

Project home
Home

Favourites

2888

& ArcGisFeatureServer
& ArcGisMapServer
) ows

& Tie Server (x¥Z)
& wes

& wrs

& wms

2 [ Render

Derseiaze @

2 Rotstion 0.0

W scale| 11,451,317 v @ Maonifier 100%

Coordinate -0.772,-0.217

H 0 Type here to search

Add road in map follow same steps which we followed to insert
footpath.
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¥ wrs

& wms
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Coordinate 0.151,-0.498 ¥ scle| 11,461,317 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
= = g 1. @ 2,
O &0 D

0

’. % RkE*I0 “@E%SERTE & &
Layers Panel

Vo lw @ mTars o

=

X # shop
% /- road
% [ ] garden
% 4 footpath

% [F take
@ - road - Feature Attributes B

Browser Panel
2T ®*eO
Froject home
Home width [60 a
Favourites
cf
D:f
Eif
Rl
g D82
MssQL
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer

) ows
& Tie Server (xYZ)
@ wes
& wrs

& wms

id 1 e

name | vijay marg a

&
4
HHQ

BE88

Cancel

Coordinate 0.723,0.196 W scale| 11,461,317 |~ @@ Magnifier 100% o Rotation 0.0 < Render @) erscraze @

H O Type here to search

To get back to normal mode

You can stop editing for layer by clicking || “toggle editing” button.

It will ask to save the fill press “Save”.
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Project home
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D:f
B/
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) ows
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Toggles the editing state of the current layer Coardinate -2.407,0.758 W scale| 11,451,317 v @ Maonifier 100% 2| Rotation 0.0

H 0 Type here to search

é
Project Edit View Llayer Settings Plugins Vector Raster Database Web Processing Help
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x road
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% [ take
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7 "
Erowser Panel /' Stop editing 1% “

aT®e Do you want to save the changes to layer lake?
Project home

Home
Favourites

B8 0

Discard Cancel

BE88

Rl
g D82

MssQL
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer
) ows

& Tie Server (xYZ)
wes

¥ wrs

& wms

Coordinate -2.327,0.811 W scale| 11,461,317 |~ @@ Magnifier 100% o Rotation 0.0

H O Type here to search

2 [ Render

T

< (% Render

- x
Derseiaze @

D ersciaze @

Add garden in map follow same steps which we followed to insert lake.
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& wms
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é

Project Edit View layer Setngs Plugins Vector Raster
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- O
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X — road
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x [ take

4
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@& ows

& Tie Server (xYZ)
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H O Type here to search
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D O T o e e s s v s - " 3EErs.
NEBRGR (02 DR ALABIR Q& H-5-LEE L - [0
s/]8 .fa BRE ¢ =@E%E %% & &
g fare Lo cpts )
« & wT e\ i 2 e
. e
ITvovamee-| B ATErs.
@
Browses Panel
g AeRT®O
Y| Project home
9, ELE
sl
Vie|e 5
- = MSSQL
IV o, 5
itvoyage | 3= AEErS.
8 e
- () OWS
& wres
& wms

voy gl e S

- T F T

itvoyagett’its itvoyagers.in itvoyagers.in itvoyagers.in itvoyagers.

i

i

Ty

i

I

i

i

i

Jin

Ty


http://itvoyagers.in/

ITVoyagers

. (itvoyagers.in) L. . . . . .
itvoyagers.in ity Oyagers.in itvoyagers.in itvoyagers.in itvoyagers.in

/ QGIS 2.18.26 - pract1
Project Edit View Layer Settngs Plugine Vector Raster Database Web Progessing  Help

NEBRLRRAHOIP2L,pRPPRALBIR 6 - H-§-,EEE=-0 0
P/B - sRE%PHE "QEAERTE A

Panel Layer Stying

Mawva-220 [ owan |
. % # shop oot .
itvoyages | I'E, = Bgers.in

% [ take o=

'v - % || garden

Q'

% NNNNN

@v

%

agers.in

word [0
Blend mode [ Normal
[ Apply label text substitutes

G

itvoyage (o][¢ momene s FTETS [
Coordinate 0.263,0.281 | saken142517 v @ Meoifier 100% |5 Rotation (X Rencer @ erseieize @

H O Type here to search a i - > P Wl @ Q A & 7z, 71 =

Select layer on which you have to add label to.
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For calculating line length.

Link to download resource file
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Layer > Add Layer > Add Vector Layer
Y] Rl & @ E-T-&-0 L m-e (O~
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. g n ed Lt roups L aster La Cirl+Shift+R e -
Itl | :I'l | a ﬂ'E 7. v R, add PostGIS Layers... Cul4shift4D == > EI'EI' T I I'I
" P = i Copy style Cirl+shift+L = -

/% Add Spatielite Layer...

o 4 4 [J Pastestyle I Add MSSQL Spatial Layer... Ctrl+8hift+M
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E2 / Toggle Editing @, Add Oracle Spatial Layer... Crrl+shift+0
[} save Layer Edits @) Add WMS/WIMTS Layer... Ctrl+shift+
' # CurrentEdits 4 Add ArcGIS MapServer Layer...

a” Save As... @3 Add WCS Layer..
@ - Save As Laver Definition File... & Add WFS Layer...

1 Remove Layer/Group Ciri+D &) Add ArcaIs Fe: Layer.

[ Duplicate Layer(s) 9, Add Delimited ayer..

. ® .
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Select “file” as source type.

Select system in encoding.

_ Click on browse o o o _
itvoyagers.in itvoyagers.in itvoyagers.in itvoyagers.in itvoyagers.in

. J
Navigate to the resource file and select
“ne_10m_railroads_north_america.shp”.
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Local Dk () Encoding | System
‘i Local Disk (C:
= New Volume (E) Source
= HP_TOOLS (F) o
o Network v o< >
Open Cancel
File name: | ne_16m_railroads_north_america.shp | [Arfies ¢y ¢ ~
@& ArcGisFeatureServer
& ArcGisMapServer
@& ows
& Tie Server (xYZ)
@ wes
P wrs
& wms
Coordinate -2.751,1.632 ¥ scle| 11455437 v @ Maonifier 100% | Rotation 0.0

H 0 Type here to search

Glicki on ffOpen”
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Settings

Plugins
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PE-R R RSN el

Browser Parel
2T®*O
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e MssQL
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) ows
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& wms

H 0 Type here to search
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/ QGIS 2.18.26 - prac2 - x
Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help
= = e N om A = —
DB RLN PP RPp e, LB =y T E
[ e (W & aE GE G G lcsw
¥ 5] 8 W B = = o g ]
Layers Panel
o § & T & 6 L
¥ — ne 10m railroads north america
Browser Panel
% BRTHO
[+]
Home
1%} Fovourts
VA o
- D:f
B/
By
?DBZ
MssQL
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
ArcGisMapServer
ows
& Tie Server (xYZ)
wes
& wrs
& wms
Coordinate -109.2,44.1 ¥ scle|136,195374 | @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Select-layer and-click-on| "/ “Open AttributéTahle”

/ QGIS 2.12.26 - prac2 - b4
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
S= = [ [ LI | —
D=8 R PAPAPE g @ &-| L v
— = - P L — Open Attribute Table
¢ m/x T % B B W B = = % =5 2
Lzyers Panel
Yo |« 3@ T a~@FAD0
'é X ne 10m railroads north america
(]
@ -
Browser Parel
9% |[GRT®O
[+]
Home
% Favourites
i
L'/ D:f
B/
i/
enaz
mssQL
@ oOrade
@ rostars
£ spatialite
& ArcGisFeatureServer
& ArcGisMapServer
ows
& Tie Server (XV2)
wes
@ wrs
& wms
Coordinate -62.5,68.6 ¥ scle|135023838 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H 0 Type here to search

Right click on layer and select from “Open Attribute Table” menu.
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7 QGIS 2.18.26 - prac2 - X
Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help

= & [ [ —
O L 1o e vl T
/ ) abc C5)
J/ B esw] - A
Layers Panel
‘o |« @ e T &~-F B O
) Zoom to Layer
Show in Overview
[ Remove
] Duplicate
Set Layer Scale Visibility
Set Layer CRS
Set Project CRS from Layer
Styles >
Browser Panel
Open Attribute Ta
% BRTHO Toggle Editing
Home Save As..
(Ff;”“”tes Save As Layer Definition File...
i Eilter...
Ef Show Feature Count
i/
S Properties
MSSQL Rename
@ orade
@ rostars
/' spatalite
& ArcGisFeatureServer
& ArcGisMapServer
& Tie Server (xYZ)
@ wes
A7 wrs
& wms
Coordinate -153.3,44.0 ¥ scle|135023838 v @ Maonifier 100% | Rotation 0.0 2 ®Render Dersgiazze @

H O Type here to search

We haveito add-length attribute:

Click on = “Open field calculator” or press “Ctrl+i”

EHS O:
HOME ~ INSERT  DESIGN  PAGELAYOUT  REFERENCES  MAILINGS  REVIEW  VIEW vijay rawool ~
3 Cut /' ne_10m_railroads_north_america :: Features total: 1127, filtered: 1127, selected: 0 - a X | i Find -
paE Copy J 7B o ole LT E @ P o 6 = ?‘ o] Shereplace
- < Format Painter F 17| [} select~
scalerark featweda | sva3 | udent add |Openfied calistor 14D Jnent | B
Clipboard i ~  Editing ~
1 8|Railroad UsA 1506 o 0 | North America
2_ 9| Railroad UsA 1606 1 5 |North America
3_ 8 |Railroad UsA 1706 o 0 | North America
4_ 8 |Railroad USA 1306 ] 0 | North America
5_ 8 |Railroad UsA 1906 o 0 |North America
3 8 |Railroad UsA 2008 o 0 |North America
7_ 8 |Railroad USA 2106 ] 0 |North America
EI_ 9 |Railroad USA 2206 1 5 North America
E_ 8| Railroad UsA 2308 o 0 |North America
r 8 |Railroad USA 2408 0 0 | North America
T 8 |Railroad UsA 2506 o 0 | North America
T 8 |Railroad UsA 2608 o 0 |North America
13_ 8 |Railroad UsA 2706 o 0 | North America
T 8 |Railroad UsA 2806 o 0 | North America
T 9| Railroad UsA 2906 1 5 |North America
T 9 |Railroad Usa 3006 1 5| North America =
T Show All Features E =

PAGE3ZOF32 167WORDS [[F  ENGLISH INDIA)

O Type here to search
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In field calculator
Enter following values
[T oy ageQutput fieldnames= tength (name afattribute) tvoyvagers.in itvoyagers.in
Output field type — Whole number (integer) (datatype for the field)
Output field length - 10
DV Oy 3 EYou tan giveany Naluesiyolwant2ZErs. N Itvoyagers.in itvoyagers.in

We have set expression for this field
Foyd E*ﬂrorﬂ"‘dedmetwghbdel Lélbct “Slen ':’tt'ﬁln N IOy agEers.n Ivoyag

Click on “Slength”

r

It will appear in expression window now add “/ 1000”.
tvovagers in tyoyagers.in itvoyagers.in itwon Fagers.n Ioyagers.n

-r-_-r_-_-_ . Fo r-_-r_-_-_ -l W el R fa -
) ' )

And click ”'OK’

Note: when we click “OK” QGIS will divide the length of roads and will
store it in length field. QGIS will calculate the length with help of

. oorﬂln tes. ~ . " I e
hvoyagers (M it Oyagers.in |--.-:.-35rs > 1n itvoyagers.in itvoyagers.in

B HS O- r ctical \ docx - Word
FILE HOME ~ INSERT  DESIGN  PAGELAYOU  Field calculator ? x vijay rawool - H
ey X 4 [V s, - -
D Cut @ ne_10m_railroads_north_ame| ] Grly update 0 selected features m] x b i Find
ER) Copy 7 = R = 5 Replace
Paste " /S 28R O | & % createanew Update existi L ac Repl
. ¥ Format Paint: = [} Select~
scalerank feat] [ | Create virtual field
Clipboard 5 5 Editing -~
7 s |Ralrosd | Oumutfiedname |length
[ scalerank: =)
Cutput field type | Whole number (integer) -
g 9|Rairoad =
I utput fieldlength |10 |3 Precision IR
FTE - —— ITErs.in
-l W e e Expression | Function Editor | bl -
- 4 8 |Rairoad -
G | | S 1 8 1 0 10 [ Search function $length
5 8 |Ralroad
length / 1000 j‘s‘;’“ 1o verte [+] | Returns the tength of a inestring. If
& & |Rairoad istance_to_vertex you need the length of a border of a
nd_point
axterior ring polygon, use Sperimeter instead. The
B o |rairoad el length calculated by this function
Seom from gl respects bolh the current project's
~ + |Ratrosd geom_fram_wkt elipsoid setting and distance unit
settings. Eg, If an elipsoid has been
set for the project then the calculated
g 8|Rairoad length wil be elipsoidal, and if no
€lipsoid s setthen the calculated
10 8 |Railroad length will be planimetric.
1 8 |Ralroad n syntax
L Pimreect bbox - -
LT T E " T o desed S1engtn FEEr%. 1N
=l fan® W el e Engmm bl P -
- eng Examples -
13 8 |Rairoad | D - line_interpolate_angle
" 1i”E,1HhEVDﬂ‘EhEJ°i"t * 3length —42.4711
14 8|Rairoad | outpyt preview: 0.00839889622470673 e neatn noin
15 9 |Ralroad
Yfou are editing information on this layer but the layer is currently not in edit mode. If you dick Ok, edit mode will
e o= automatically be turned on. E
T show All Features _ .
T o | e [ 1
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da prac2 —
Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help
/' ne_10m_railrosds_north_america i Features totsl: 1127, filtered: 1127, selecteds 0 - o x ﬂ
’ B v z 8 € P TES DB BRE S
> . )
123scalerank |+ - Update Selected
¢ & % T scalerank featreda | sova3 | uident add natriscale continent length
Y 0 @
7 ol 8 [Rairoad UsA 1506 0 0 North America 835
ne
2 9 |Rairoad UsA 1606 1 5| North America 30
E 8 [Rairoad usA 1706 0 0 North America 122
4 8 |Rairoad UsA 1806 ] 0 North America 2
5 8 |Rairoad UsA 1306 0 0 North America 0
6 8 [Rairoad usA 2006 0 0 North America 110
7 8 |Rairoad UsA 2106 0 0 North America 77
,D & T Me 9| Railroad usa 2206 i 5 | North America 231
Home s 8 [Rairoad UsA 2306 0 0 North America 34
QH Favourites —
W cf 10 8 [Rairoad UsA 2406 0 0 North America 20
@ D:f —
Ef 1 8 |Rairoad UsA 2506 0 0 North America 205
Fif —
? D82 12 8 [Rairoad UsA 2606 0 0/ North America 34
mssql
®@ome |8 8 [Rairoad UsA 276 0 0 North America 2
; :;Zt;ﬁtg 1 8 |Rairoad usA 2806 0 0 North America 7
% i“g‘s::a: 15 9|Rairoad usa 2908 1 5 | North America 72 &
cisMapt =
0 ows -
& Tie Server {|_ T Show All Features | E
@ wes
A7 wrs
& wms
Toggles the editing state of the current layer Coordinate 74.3,0.7 W scale|1:35,023838 v @ Maonfier 100% |3 Rotaton 0.0 2 ®Render Dersgiazze @

H O Type here to search

Calculating lengths of line is done.

Nowi length field is-added, close-the window;
Now we have to generate Statistics.

Go to

Vector > Analysis Tools > Basic statics for numeric fields

/ QGIS 2.12.26 - prac2 - b4
Project Edit View Layer Settings Plugins Raster Database Web Progessing Help
= =5 Openstreetiap v N A — — T
D Research Tools v G»z 2] mm Y g v
Geoprocessing Toals~ *
Seen < abe csw] @
. Geometry Tools >
Analysis Tools #3 Countpeints in polygon
¥o T Mean
' - W< Line intersections
Bl - ' [EE Basic statistics for text fields
ﬁ " Nearest neighbour analysis
[ Distance matrix
' #E| Basic statistics for numeric fields
@ - iD List unique values
72 Sum line lengths
Browsr Panel
9% RRTTO
Home
@ Favourites
cf
L'/ D:f
B/
Ff
e D82
MssQL
@ oOrade
@ rostars
£ spatialite
&) ArcGisFeatureServer
@ ArcGisMapServer
0 ows
& Tie Server (XV2)
@ wes
& wrs
& wms
Coordinate -133.3,70.6 % scale (135,023,838 | v @ Megnifir 100% |2 Rotation 0.0 2 M Render Herseiaaze @

H O Type here to search
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Select the railroads layer in “Input vector layer”.

a4

Project Edit View Layer Settings Plugins

Vector Raster Database Web Progessing Help

S B o &) O A
BECR {02 sp 00 Tme e ==y -
D LV Y = /' Basic statistics for numeric fields ? e
‘ool ‘o /X
Layers Panel . - .
e Parameters | Log Run asbateh process... | | Basic statistics for numeric
« & T &~FF fields
Input vector layer
% # ne 10m railroads north This algorithm generates basic statistics from the
’ e et s | BEled sty of a rmeric e m e athibute table of
ne_10m ralroads_north america [EPSG:4326 a vector layer.
length +] | | statstics are generated ac an HTML fie.
Statistcs
[Save to temporary file] ]
Browser Panel
9% BRTHO
(4]
Home
%] Fovaies
=]
L £ D/
Eif
Fif
? D62
MsSQL
@ orade
@ posters
/' spatalite
" meserestuesare I 0%
& ArcGisMapServer a
) ows ose
& Tie Server (xVZ)
& wes
& wrs
& wms
Coordinate W scole (135,023,838 v @ Magnifier 100% = Rotaton 0.0 S ®Render @Depsciaze @

H 0 Type here to search

Select “length” attribute in “Field to calculate statistics on”

7
Project Edit View Layer Settngs Plugins Vector Raster Database Web Progessing Help
=] @ &, = @ nogm A —_
D ur 0 \TW A L G\R - M
Ape gt % pe |/ Basic statistics for numeric fields 7 x
’_ B ‘B la” o %
L Pane! = P -
s Parameters | Log Runasbaichprocess... | | Basic statistics for numeric
B ET G- Input vector layer fields
% # ne 10m railroads north . This algorithm generates basic statistics from the
ne_10m.rairoads_north_smerica [EPSG:4326] analysis of a numeric field in the attribute table of
Field to calculate statistics on a vector layer
add <] | | Statistics are generated as an HTML fie.
2dd
e
natscale
scalerank
uident
Browser Panel
9% BRTTO
o
Home
1%} Fovourts
AV o/
- D:f
Ef
Fif
? D82
mssQL
@ crade
@ rostars
/' spatalite
© non I %
& ArcGisMapServer g
@ ows s
& Tie Server (xYZ)
@ wes
@ wes
& wms
Coordinate -85.5,1.4 ¥ scale|1:35,023838 v Magnifier | 100% 5| Rotston 0.0 2 ®Render Dersgiazze @

H O Type here to search

We have to save the resulit.

Click on =~ button and select “Save to file...”
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7z

Project Edit View

DEB RS

layer Settings Plugins Datzbase Web Proessing Help

HO e p pn

Vector  Raster

2>

B-8-EEZ m-,

/' Basic statistics for numeric fields

Layers pane!
« @l w T &~F 7

% # ne 10m railroads north

g
Parameters | Log

(]

Input vector layer

ne_10m_rairoads_north_smerica [EPSG:4326]

Field to calculate statistics on

length

Statistics

- [Save to temporary fi]

Vo
=
£
Q-
]
&

Browssr Panel

9 LT ®TO

%

Home
Favourites

? pad

Run as batch process

Basic statistics for numeric
fields
This algorithm generates basic statistics from the

analysis of a numeric field in the attribute table of
a3 vector layer.

- Statistics are generated as an HTML file.

By Saveto a temporary file

Save to file...

Use expression...

0%

& ArcGisMapServer
ws

Close

& Tie Server (xVZ)

& wms

H O Type here to search

Coordinate -82.6,2.0

W scale|1:35,023,838 ~ @@ Magnifier 100% o Rotation 0.0

| Render

D ersciaze @

0

Select the path and enter the file name “total-length” extension will be

“.html” and click on “Save”.

7z

Project Edit View

Datzbase Web

Layer Settings Progessing  Help

Plugins

Vector  Raster

= B ] LU= |
N [ - Y o) mm 7 g
Layers Panel parameters y flum et umeric
\Vs Save file ? X
C ¢ @ ®T &~ T N
= || Input vector lay
% # ne 10m railroads north. Lookin: Ex\SarvasvalQGIS|2 - 5] fistics from the
ne_10m_rairos e @ & ttribute table of
ﬁ Field to calcuiate | W)y Computer IND_adm
— ne_10m_rairoads_north_america L file.
Q leng 2 welcome '
v
Statistics
@ < [Save to temp
Browser Panel
aeT®o
Home
Favourites
cf
D:f
E:f
P/ Flename: | totaHength
? D82
MssQL Files of type: | HTML files(=html) - Cancel
@ orade
@ rostars Encoding: | System -/
£ spatialite ﬁ

& A
& ArcGisMapServer

Close
& Tie Server (XV2)
@ wes
& wrs
& wms
Coordinate ¥ scle|135023838 v @ Maonifier 100% | Rotation 0.0 X Render D epsciazze @

H 0 Type here to search

Now click on “Run”.
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7
Project Edit View Laver Settings Plugins Vector Raster Database Web Processing Help
= g Fl @ - NN A . -
CEEYERE Y Y L e Q- LEET =G
Rpe o A pe ¢ Basic statistics for numeric fields ? X
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B ET G- Input vector layer fields
% # ne 10m railroads north . This algorithm generates basic statistics from the
ne_10m.rairoads_north_smerica [EPSG:4326] analysis of a numeric field in the attribute table of
Field to calculate statistics on a vector layer
length +| | | statistics are generated as an HTML fie.
Statistics
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Browser Panel
9% BRTTO
Home
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goaz
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& Tie Server (xYZ)
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Coordinate 826,20 ¥ scle|135023838 v @ Maonifier 100% | Rotation 0.0

H 0 Type here to search

it-will-generate statistics;
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Settings  Plugins
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# Results

Layers Panel
« i ® T &~@ * |

% # pe 10m railroads north
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Algorithm Basic
Converting autputt
Loading resulting |

Browser Panel
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Home
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e D82
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@ oOrade

@ rostars

£ spatialite

Loading resulting la

& ArcGisMapServer

7 x

Analyzed layer: ne_10m_ralroads_north_america .
numeric
Analyzed field: length

Count: 1127 tatistics from the

Unique values: 407 attribute table of

Minimum value: 0.0 B se.
Maximum value: 1060.0

Range: 1050.0

Sum: 181356.0

Mean value: 160.919254658

Median value: 121.0

Standard deviation: 164814336273
Cosfficient of Varistion: 102420519299
Minority {rarest occurring value): 61,0
Majarity (most frequently occurring value): 4.0
First quartile: 33.0

Third quartie: 226.5

NULL (missing) values: 0

Interquartile Range (IQR): 187.5

& Tie Server (XV2)
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V' wrs
& wms
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